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Standard Operating Procedures (SOP) for: CYTOLOGY – Morphology Analysis   
 
SOP Number: 1.0 Version Number: 1 
Effective Date:  Review Date:  
 
Author: Lorraine Frew  
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown – HABSelect Co-Lead Laboratory Investigator 

 
Authorisation: 
Name / Position David Miller – HABSelect Chief Investigator 
Signature  

Date  
 
Purpose and Objective: 
 Purpose:  

- To clearly document the process of performing morphology analysis on modified papanicolaou 
stained sperm. 

 
Objective:  

- To ensure delegated research staff members conduct this analysis according to standardized 
protocol. 

 
 
SOP Text 
  
Sperm morphology evaluation is conducted according to Tygerberg strict criteria. In these criteria a 
typical spermatozoon is defined as having an oval form with a smooth contour and a clearly visible 
and well-defined acrosome with homogeneous light-blue staining. The tail should be apically inserted 
without any abnormalities of the neck/midpiece and tail region and no cytoplasmic residues at the 
neck/midpiece or tail regions.  
 
The typical sized acrosome should cover 30-60% of the anterior part of the sperm head. The typical 
sized head will measure between 3.0 and 5.0 µm in length and 2.0-3.0 µm in width. The midpiece 
should not be longer than the 1.5 x the length of a typical head and about 1 µm thick. The tail should 
be about 40-50 µm long and without any sharp bends. No cytoplasmic material should be present at 
the head/neck junction or along any part of the tail, however a smooth droplet/residue of <30% of the 
normal sized sperm head is still regarded as normal.  
 
Atypical spermatozoa are those that deviate from the defined criteria for morphologically ideal 
spermatozoa, due to differences in size, structure, or form. The assessment relates to the main regions 
of the spermatozoon and abnormalities will be tallied for each of the four categories;  
 

Ø Head defects 
Ø Neck/Midpiece defects 
Ø Tail defects 
Ø Cytoplasmic droplet defects  

 
An abnormal sperm may have abnormalities in one to four of these categories.  
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Equipment and materials required  
 

• Microscope with bright field illumination  
• Cell counter  
• Immersion oil  
• Lens cleaning paper  

 
 
Protocol  
 

1. Scan the smear to observe the spreading of the spermatozoa in the smear, the staining quality 
and the presence of round cells.  
 

2. Identify suitable areas for the performance of the sperm morphology evaluation.  
 
 

3. Sperm morphology should ideally be performed in more than one area to increase the 
accuracy and evaluation.  
 

4. Assess at least 200 spermatozoa.  
 

5. Record the morphological appearance of each spermatozoon as normal or abnormal. Assign 
four buttons on the counter for each of the four types of abnormalities. When a spermatozoon 
is scored as abnormal the button for the specific abnormality is depressed; if more than one 
defect is present the buttons for each defect are depressed simultaneously. In this way all the 
defects of the spermatozoon will be scored, but eh abnormal spermatozoon will only be 
counted once.  

 
 

Calculation of results  
 
The proportion of typical spermatozoa is calculated by dividing the number of spermatozoa assessed 
as “typical” by the total number of spermatozoa assessed. The result is given as an integer percentage 
(no decimal places e.g 5% not 4.8%).  
 
Proportion of abnormal sperm and sperm with defects in the four categories are presented in the same 
way. While the total number of typical and abnormal cells will add up to the total number assessed, 
the sum of all abnormalities will be greater than the total number of spermatozoa that have been 
assessed.  
 
Each morphologically abnormal spermatozoon will have any one of the four types of abnormalities 
described, or any combination of two to all four abnormalities. To reflect this The Teratozoospermia 
Index (TZI) is used as an indication of the average number of defects per abnormal spermatozoon. To 
calculate the TZI, the sum of all recorded abnormalities is divided by the total number of abnormal 
spermatozoa. Since any given spermatozoon can have between one and four abnormalities, the TZI 
result will always be between 1.00 and 4.00.  
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Example Presentation of results;  
 
200 sperm assessed in total: 
10 normal sperm = 5%  
190 abnormal sperm 

- 186 with head defects = 93% 
- 33 with neck/mid-piece defects = 16% 
- 48 with tail defects = 24% 
- 8 with abnormal cytoplasmic material = 4% 

 
TZI = (186 + 33+ 48+8)/190 = 275/190 = 1.45 
 
 
 
 Responsibility Activity 
1.   

2.   

3.   

4.   

5.   

6.   

7.   
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Standard Operating Procedures (SOP) for: Cytology – Modified Papanicolaou Staining  
 
SOP Number: 02 Version Number: 1 
Effective Date:  Review Date:  
 
Author: Lorraine Frew  
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown – HABSelect Co-Lead Laboratory Investigator 

 
Authorisation: 
Name / Position David Miller – HABSelect Chief Investigator 
Signature  

Date  
 
Purpose and Objective: 
 Purpose:  

- To clearly document the process of performing Modified Papanicolaou Staining Protocol using 
an automated slide staining machine.  

 
Objective:  

- To ensure delegated research staff members conduct this assay according to standardized 
protocol. 

 
 
SOP Text 
  
Equipment Required  
 

• Leica Autostainer XL 
Leica Biosystems  
Equipment currently used in Birmingham – Serial # XL074996 

 
 
Solutions Required  
 

• Ethanol Absolute  
Used to make 50%, 70%, 80% and 95% EtOH  
VWR Chemicals, 20821.330 

 
• Harris Haematoxylin 

Surgipath, Leica Biosystems, 3801560E 
 

• Scott Tap Water Substitute  
Surgipath, Leica Biosystems, 3802901E 

 
• 0.5% HCl – 1ml concentrated HCl in 200ml H2O 

 
• Papanicalou Stain Orange G6 

Surgipath, Leica Biosystems, 3801660E 
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• EA-50 
Surgipath, Leica Biosystems, 3801620E 

 
• Clearium Mounting Medium  

Surgipath, Leica Biosystems, 3801100 
 

 
Additional Items  
 

• Coverslips – 2.4 x 50 mm 
 

 
Protocol  
 
 

1. Fix slides for at least 10-15 minutes in absolute EtOH 
 

2. Transfer slides to the staining rack  
 

3. Load slides in to AutostainerXL 
 

4. Slides will follow pre-programmed protocol as follows;  
 

Step  Reagent  Exposure  
1 80% EtOH 10 dips = 10 seconds 
2 70% EtOH 10 dips = 10 seconds 
3 50% EtOH 10 dips = 10 seconds 
4 Distilled water 10 dips = 10 seconds 
5 Harris’ Hematoxylin  5 minutes 
6 Rinse in running water 3 minutes 
7 0.5% HCl 2 dips = 2 seconds 
8 Rinse in running water  5 minutes 
9 Scott’s Tap water  1 minute 
10 Rinse in running water  2 minutes 30 seconds 
11 50% EtOH 10 dips = 10 seconds 
12 70% EtOH 10 dips = 10 seconds 
13 80% EtOH 10 dip s= 10 seconds 
14 95% EtOH 10 dips = 10 seconds 
15 Orange G6 5 minutes 
16 95% EtOH 5 dips = 5 seconds 
17 95% EtOH 5 dips = 5 seconds 
18 EA-50 5 minutes 
19 95% EtOH 5 dips = 5 seconds 
20 95% EtOH 5 dips = 5 seconds 
21 95 % EtOH 5 dips = 5 seconds  

 
 

5. Once the protocol is complete unload slides from the Autostainer XL 
 

6. Mount slides with Clearium Mounting Solution and allow to dry 
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 Responsibility Activity 
1.   

2.   

3.   

4.   

5.   

6.   

7.   
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Standard Operating Procedures (SOP) for: TUNEL Assay  
 
SOP Number: 03 Version Number: 1 
Effective Date:  Review Date:  
 
Author: Lorraine Frew  
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown – HABSelect Co-Lead Laboratory Investigator  

 
Authorisation: 
Name / Position David Miller – HABSelect Chief Investigator 
Signature  

Date  
 
Purpose and Objective: 
 Purpose:  

- To clearly document the process of performing TUNEL assay 
 
Objective:  

- To ensure delegated research staff members conduct this assay according to standardized 
protocol. 

 
 
 
SOP Text 
 
 
 

 
Kit Required  
 

• In Situ Cell Detection Kit, Fluorescein  
Roche, 11 684 795 910 
 

• DNase I recombinant  
 
Solutions Required  
 

• Phosphate Buffered Saline (PBS)  
(PBS Tablets, Sigma, P4417, dissolved in dH2O) 

 
• 2mM DTT (Dithiothreitol) in PBS – Freshly Prepared  

(DL-Dithiothreitol, Sigma, D9163-5G, stored at 5ºC) 
 

• Permeabilaztion Solution; 10 mg Sodium Citrate, 10µl Triton x-100 in 10 mls dH2O – 
Freshly Prepared (Sodium Citrate, Sigma, S4641. Triton X-100, Sigma, X100-100.) 

 
• PFA (Paraformaldehyde) – 4% PFA in PBS, pH 7.4  

(Paraformaldehyse, Powder, 95%, Sigma,158127) 
 

• DNAse Diluent – 50mM Tris-HCl, pH 7.5, 1mg/ml BSA) 
(Tris (hydroxymethyl)aminomethane,Sigma, 252859 . Bovine Serum Albumin, Sigma, 
A7906).  
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• Clearium Mounting Medium  

Surgipath, Lecia Biosystems, 3801100 
 
 
Additional Items  
 

• Coverslips – 2.4 x 50 mm 
• Humidified Chamber  
• Ice 

 
 
Protocol 
 

1. Incubate slides in 2mM DTT (in PBS) for 45 minutes at Room Temperature: 
Place slides in a coplin jar containing 2mM DTT 
 

2. Wash slides with PBS – 1 x 5 minute wash: 
Place slides in coplin jar containing PBS 

 
3. Fix slides with PFA for 15 minutes on ice – This must be carried out within a fume hood ;  

Places slides in coplin jar, placed on ice, containing PFA (as described in solutions) 
 

4. Wash slides with PBS – 3 x 5 minute wash;  
Place slide in coplin jar containing PBS, remove in to fresh PBS at 5 minute intervals x 3 

 
5. Incubate slides in Permeabilization Solution for 2 minutes on ice;  

Places slides in coplin jar, placed on ice, containing Permeabilization solution (as described in 
solutions)  
 

6. Wash slides with PBS – 2 x 5 minute wash;  
Place slide in coplin jar containing PBS, remove in to fresh PBS at 5 minute intervals x 2 

 
7. Positive control samples need to be included in each experimental set up. Make DNase I 

recombinant solution to a concentration of 3U/ml in DNase Diluent (see solutions above), 
dilution will dependent on stock concentration of DNase I recombinant.  
 

8. Add 25µl DNase I solution to 2 slides and add a coverslip to each slide. Place the slides in a 
humidified chamber and incubate for 60 minutes at 37ºC. All other slides remain in PBS 
during this incubation period.  

 
9. Wash slides with PBS – 2 x 5 minute wash; 

Place slide in coplin jar containing PBS, remove in to fresh PBS at 5 minute intervals x 2 
 

10. From the In Situ Cell Detection Kit remove one pair of tubes (vial 1: Enzyme Solution, and 
vial 2: Label Solution) – This is sufficient for staining 22 samples by using 25µl TUNEL 
reaction mixture per sample and  2 negative controls by using 25µl Label Solution per 
control. 
 

11. Remove 50µl Label Solution (vial 2) for 2 negative controls. Add total volume (50µl) of 
Enzyme Solution (vial 1) to the remaining 450µl Label Solution in vial 2 to obtain 500µl 
TUNEL reaction mixture. Mix well to equilibrate components. 

 
12. Add 25µl of TUNEL mixture to each slide  
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13. Add a coverslip to each individual slide and place the slides in a humidified chamber. 

Incubate the slides for 60 minutes at 37ºC  in the DARK  
 

14. Wash slides with PBS – 3 x 5 minute wash; 
Place slide in coplin jar containing PBS, remove in to fresh PBS at 5 minute intervals x 3 
  

15. Mount slides with STILL TO BE DECIDED and allow to dry (protect from direct light) – 
This must be carried out within a fume hood  

 
 
 
 
 Responsibility Activity 
1.   

2.   

3.   

4.   

5.   

6.   

7.   
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Standard Operating Procedures (SOP) for: General sperm sample processing for 
downstream analyses. 
 
SOP Number: 04 Version Number: 1 
Effective Date:  Review Date:  
 
Author: D. Miller 
Reviewed by  
(Name/ Position): 

J.Kirkman-Brown 

 
Authorisation: 
Name / Position David Miller – HABSelect Chief Investigator 
Signature  

Date  
 
Purpose and Objective:  

Purpose: To prepare sperm cells for slide-based downstream assays. 
Objective: To provide continuity in sample processing to ensure that the numbers of 
sperm being loaded on to assay slides is both useful to the assay (in terms of sperm 
numbers) and the operator (in terms of workload and demand) and gives consistent 
results. 
Scope: To allow the rapid assessment of at least 100 sperm nuclei in each sample. 

 
SOP Text 
 
 
 

Introduction to technique 
In order to support the downstream analysis of sperm samples acquired by HABSelect (for 
example), it is necessary to process the samples such that cell numbers are adequate for 
the purpose of the tests. This SoP deals directly with processing to support slide-based 
assays including Acridine Orange (SoP No), Aniline Blue (SoP No) staining and Tunel 
labelling. It can in principle be applied to many other slide based assays including general 
staining and immunocytochemistry. Comet (SoP No) and Halo (SoP No) assays have their 
own sperm prep protocols to follow. 
 
Reagents and equipment required 
Unless otherwise stated, all working stocks and solutions MUST be made up with Analar 
grade reagents.  

1. A supply of 15 ml Falcon tubes for centrifuging samples. 
2. A set of 1000 µl and 200 µl range pipettes with disposable tips. 
3. A supply of phosphate buffered saline (PBS), pH 7.4 (freshly prepared from tablets or 

powder (Sigma). Once made up, this can be stored for up to 10 days at 4°C. 
4. Microscope slides, acid washed and coated with poly-L-lysine (Supplier?) 
5. Copling vessels (for fixing samples and washing slides). 
6. SpermBlue staining agent (Microptic) or equivalent if image capture is required. 
7. Microscope equipped with x25 and x40 objectives. It is preferable to use the same 

microscope that is to be used for all downstream analyses.  
 

Sample Processing 
All samples arrive frozen in 500 µl aliquots. They should be stored at -80°C prior to 
processing. 

1. Rapidly thaw sample out by placing in a 37°C water bath. Mix gently and transfer to a 
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15 ml Falcon tube. Slowly add 500 µl of  PBS (room temp), continuing to mix gently. 
Pellet sperm by centrifugation at 500g for 10 min at room temperature and remove 
supernatant. 

2. Using a 100 µl Gilson-type pipette, gently resuspend the pellet in 100 µl of PBS held 
at room temperature and add another 400 µl of PBS, mixing gently.  

3. Centrifuge as before and resuspend pellet in 150 µl of HBS. 
4. Use a Neubauer chamber to count sperm (see below). The chamber comes with a 

thickened glass coverslip that is put in place before adding the sample. Using the 
edges of your thumbs, carefully slide the coverslip over the surface of the chamber, 
applying firm but not excessive pressure over the whole surface of the coverslip. A 
coverslip that is correctly positioned will generate Newton's rings (iridescent colours) 
around its edges when the chamber is held at a slight angle and you look across the 
coverslip. 

5. Add 10 µl of your sample to the edge of the coverslip and allow the liquid to be drawn 
between the  coverslip and chamber by capillary action. 

 
6. Place the chamber beneath a x25 objective and bring the sperm into focus on the 

first (1) of the corner squares (1, 2 , 3 or 4). Switch to x40 and using a manual 
counter, count the cells in the square, moving from left to right, row by row and 
omitting cells contacting  the right and lower edges (red crosses). The example below 

shows an optimal cell density that facilitates 
easy counting. Repeat for each of the three 
other corner squares. 
 

7.  As each of these big squares 
represents a volume of 0.0001 ml (0.1 x 0.1 x 
0.01), the total (C) of cells  per ml is given by 

the formula  𝐶 = !
!
𝑥10! . So, if N is 100, then 

the sperm concentration is  25 x 104 / ml. If the 
sample measured was diluted from the original 
sample, the dilution factor must be taken into 

account. For example, if the sample was diluted 1:10 prior to counting, the true 
sperm concentration will be 250 x 104 / ml or 2.5 x  106 / ml. There should therefore 
be 2,500 sperm per µl and you should aim to apply ~ 25,000 (10 µl)  – 50,000 (20 µl)  
sperm to the assay slide (see from section 9 onward).   
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8. In the event that the sample is either too dense or too sparse to read accurately, 
dilute or concentrate the sample accordingly to bring the sample to a final density 
that allows straightforward reading.  

Optimising sperm loading on to slides. Regardless of the method chosen to prepare 
slides, you should aim for microscopic fields at x40 magnification with 25 - 50 sperm visible 
per field. You may need to obtain at least two fields per sample to image a minimum of 50 
sperm. The sperm concentration suggested here (~106 per ml or 1000 per µl) is based on 
empirical evidence for optimal sample processing on the imaging platform at Leeds but is for 
guidance only. 

9. Adjust sperm concentration to ~106 per ml by adding HBS. If the concentration is too 
high but it is possible to adjust within the 1.8 ml volume of the sample vessel, then 
add the required volume. Otherwise, resuspend and remove the required volume 
from the sample that when added to a waiting volume of HBS, will bring the 
concentration close to 106 per ml in 250 µl total volume.  If the sample sperm 
concentration is below 106 per ml, re-centrifuge the sample and after discarding the 
supernatant, re-suspendthe pellet in a smaller volume with HBS calculated to give 
106 per ml. If it is not possible to obtain this concentration because of very low sperm 
counts, centrifuge and resuspend in the smallest volume possible that permist the 
spreading of ~10,000 sperm on either side of a coated glass slide (see point 8).  

10. Add 10 µl of the suspension (~10,000 sperm) to either side of a pre-coated glass side 
(coated side) and spread manually using the pipette tip to a diameter of up to 0.5 cm. 
If the concentration is slightly lower than 106, adjust the spreading volume 
accordingly. A cytospin (section 10) if available can also be used as an alternative to 
manual spreading. 

11. Place slides on clean blotting paper and allow to air dry for at least 60 min.  They can 
be stored at this point in covered slide containers at 4°C for later use. 

12. If a cytospin is used, add a sufficient volume of a fully re-suspended sample 
containing 10,000 sperm to 1.5 ml of HBS. Place a filter between the slide (coated 
side) and loading vessel, clamp together and centrifuge for 10 min.  Uncouple the 
vessel and place slide on filter paper as above.  

Checking slides for sample processing optimisation. 

Before any downstream assay, it is advisable to check your slides and ensure there are 
sufficient sperm available for analyses. Use the SpermBlue stain for this purpose. Please 
follow the associated Microptic staining protocol (Appendix 1). 

Sample Imaging 

Slides should be examined with the same microscope used for downstream analyses. 
1. Place slide on microscope stage. 
2. Switch on visible light source and locate the sample on one side of the slide.  
3. Adjust condenser/iris to give optimal visibility and then switch to x40, increasing 

brightness as required. 
4. Can you count 25 sperm in the field of view? 
5. If you can see 25-50 sperm in the field, then your processing has been successful. 
6. Switch to other side of the slide and repeat. 
7. You will need to visualise at least 50 sperm sperm per sample and preferably 100, so 

the number of fields required for assay imaging depends on the number of sperm 



     

Pragmatic Clinical Trials Unit 2008  SOP Number XX v X 
Not to be used without prior permission by the PCTU. 
 

4 4 

visible in any individual field. You should be able to use either side of the slide for this 
purpose. 

Recording Images 

Leeds uses SmartCapture (see SoP xxx) imaging software running on an Apple iMac. 
Images are captured from a Zeis Axiomat microscope fitted with epifluoresence and visible 
light optics and capable of capturing images at x100, x250, x 400 and x1000.  

1. Prepare microscope for visible light imaging and launch SmartCapture. 
2.  Select the option Brightfield (SpermBlue) from the list of choices available (see SoP 

xxx). 
3. Ensure camera and electronic colour filter block are ON and that the filter block is 

fully engaged in the block housing located in the microscope’s C-Mount.  
4. Focus on sample at x400 and continue to SoP xxx with reference to the 'SpermBlue' 

protocol. 
5. When you are finished, please remember to turn the camera, colour filter and 

microscope light source to ‘OFF’.  
6. Log out of the user account on the iMac. 

 
 Responsibility Activity 
1.   

2.   

3.   

4.   

5.   

6.   

7.   

 
 
 
 
Appendix 1: SpermBlue Staining Procedure  
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KIT FOR SPERM MORPHOLOGY ASSESSMENT IN HUMAN AND ANIMAL SPECIES.  

Background:  

The stain has been developed to stain all components of sperm (acrosome, head, midpiece, 
principle piece of tail and end piece) differentially in different intensities of blue. The staining 
procedure is very simple and only involves two main steps, fixing in one medium and 
staining in a second medium. It works equally well for smears of “raw” semen as well as 
swimup/Percoll/PureSperm gradient preparations, using most tissue culture media.  

Please note that only fixed/dead sperm to be stained. Not for use with live unfixed cells in 
any procedure such as in tissue culture.  

Contents of SpermBlue®:  

All SpermBlue¨ packages contain bottles/staining trays with equal volumes of fixative (clear 
or transparent solution marked Fix) and a dark blue stain (dark blue staining solution marked 
Stain).  

SpermBlue¨ is packaged in two bottles, individually containing 250 ml fixative and 250 ml 
stain. Sufficient to stain 600 sperm smears or more on slides.  

It is recommended that the fixing and staining of smears are performed in standardized 
containers,  
e.g. plastic Coplin jars, which could be provided on request.  

If fixative and stains are stored at 4°C it will last for at least one year or longer. Room 
temperature storage (20 – 25¼C) not guaranteed but normally lasts one year. Take note of 
expiry date.  
Staining Procedure:  

1. Make duplicate sperm smears using 10µl of semen or 10 to 15µl of swim-up sperm (adapt 
volume to concentration of sperm) and allow to air dry. If sperm concentration in semen is 
less than 20 million/ml, use 15µl of semen for smear. Ideal angle of slide which is used to 
make smear is about 45°. If sperm concentration is low, decrease angle of slide which is 
used to make smear to about 20¼. A larger volume of sperm will accordingly be dragged 
behind moving slide resulting in more sperm on slide. Ensure sperm smear is totally dry 
before next step. 
 
2. Carefully place dried smears vertically into staining tray (Coplin-type jar) containing 
SpermBlue¨ fixative. Take care to slowly immerse slides into fixative and leave – no 
agitation, etc. Fix for 10 minutes at 20 to 25°C. Alternatively, place dried smears horizontally 
down on filter paper (smear up). Use a plastic disposable pipette to put 0.5 to 1ml of clear 
fixative solution on dried smear, and make sure to cover the whole area of the smear. Leave 
for 10 min – do not roll from side to side. 
 
3. Carefully remove slides from staining tray and hold it at an angle of 60¼ to 80¼ to drain 
off excess fixative. If smears were fixed horizontally, let most of fixative gently run off slide 
onto filter paper. No washing or drying is needed after fixation.  

4. Carefully place fixed smears vertically into staining tray containing SpermBlue¨ stain. Take 
care to slowly immerse slides into stain and leave – no shaking or moving of slide in 
medium. Stain for 12-15 minutes at 20 to 25°C. Alternatively, place slides horizontally down 
onto filter paper after fixation. Use a plastic disposable pipette to put 0.45 to 0.5ml of stain 
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onto fixed sperm smear. Gently roll slide from side to side at regular intervals (once every 
minute) to ensure that stain is displaced equally across smear surface. Stain for 12-15 
minutes. 
 
5. Carefully remove slides from staining tray. If smears were stained horizontally, let most of 
stain gently run off slide onto filter paper. SLOWLY dip stained slides into distilled water – 
only one dip, lasting for 3 seconds is required. Immersion technique usually requires only 
one dip to wash off excess stain, but second dip might be necessary for the “drop-on” 
technique. Slides need to be very gently dipped in distilled water, preventing too many 
sperm from being lost during this washing step. Remove slides from water very slowly and 
leave in an upright position (at about 70¼ angle). Let all fluid drain from slide until air dry. 
 
6. Mount slide with DPX or equivalent synthetic medium for making permanent slides. When 
the mounting medium is dry view under oil immersion x1000 for human sperm.  
 
7. If nuclear staining is not intense enough, stain the duplicate smear for another three to five 
minutes and even longer if required.  
 
Alternative fixation procedure:  
In some instances 95% ethanol or 100% methanol fixation (coagulant fixation) may be used 
particularly after washing sperm and to concentrate sperm instead of SpermBlue¨ fixation. 
Staining procedure after alcohol fixation in SpermBlue¨ remains the same as outlined above. 
 
Important comments:  
Initial staining results may suggest either too little staining of some sperm as well as 
differences in staining intensity on the same slide. Each researcher has to experiment to 
optimize her/his results in this context. Try and adapt staining times at temperature 
conditions between 20 and 30°C. Many existing sperm staining techniques rely on “sperm 
painting” which is not cytologically acceptable. SpermBlue¨ clearly differentiates all sub-
divisions of sperm accurately and is particularly good in the identification of the sperm 
acrosome (van der Horst and Maree, (2009) SpermBlue¨: A new universal stain for human 
and animal sperm which is also amenable to automated sperm morphology analysis, 
Biotechnique and Histochemistry: In press).  
 
Examples:  
With human and sub-human primate sperm the acrosome stains light blue and the head 
dark blue. Midpiece stains distinctly dark blue, rest of tail slightly lighter blue and end piece 
even lighter blue. Suitable for SCA automatic Morphology analysis (Microptic SL, Barcelona, 
Spain). 
 
In domestic animals such as bull, boar and ram: Acrosome stains dark blue, post acrosomal 
area and particularly the equatorial zone stains light blue. Midpiece stains darker blue and 
rest of tail slightly less dark blue. 
 
 
Safety data sheet for SpermBlue®:  
 
SpermBlue¨ contains toxic components like all cytological stains but is not hazardous. The 
main active component is a slight skin, oral/nasal irritant and staining should preferably take 
place in a fume hood. If skin contact has occurred, wash affected area thoroughly with water.  
 
Precautions:  
 
All cytological stains are toxic and have to be handled with care. Always work with gloves 
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and preferably in a fume cupboard. Only stain when sperm are fixed (dead). Do NOT use for 
live unfixed cells.  

Distributed by:  

Microptic SL Viladomat 321, 6° 4a, 08029, Barcelona, Spain Tel. +34 934192910 Fax 
+34 934199426 www.micropticsl.com  
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Standard Operating Procedures (SOP) for: Acridine Orange staining of sperm 
 
SOP Number: 05 Version Number: 1.0 
Effective Date: 15-02-2016 Review Date: 15-02-2018 
 
Author: David Miller 
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown - Laboratory Co-Lead 
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Authorisation: 
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Purpose and Objective:  
Purpose: To stain sperm samples with Acridine Orange. 
Objective: To prepare sperm samples for staining with Acridine Orange. 
Scope: DNA fragmentation assay. 
 
SOP Text 
 
 
 

Introduction to technique 
Acridine orange (henceforward abbreviated to just AO) is a metachromatic dye that under the 
right conditions of pH and salt concentration, fluoresces GREEN when interacting with intact, 
double-stranded DNA and RED when interacting with fragmented, single-stranded DNA. It is 
the basis of the sperm chromatin structure assay (SCSA) that uses fluorescence activated cell 
sorting (FACS) to measure DNA fragmentation in thousands of sperm cells. The variation 
detailed in this SoP uses a slide-based alternative that better accommodates the limiting 
amount of available sample. 

 
Responsibility 
Suitably qualified personal in the research lab trained to perform the acridine orange assay. 

 
Activity 
1.  Reagents and equipment required 

Unless otherwise stated, all working stocks and solutions MUST be made up with Analar 
grade reagents.  

i. AO solution ready prepared and supplied by Polysciences, Cat No 24603. 
ii. Solutions of 0.1M NaOH (500 ml) and 0.1M NaOH (500 ml). These can be 

stored for up to one month at 4°C. 
iii. Sperm wash buffer (SWB; Origio). 
iv. Methanol  
v. Glacial Acetic Acid 
vi. Phosphate buffered saline (PBS), pH 7.0 (freshly prepared from tablets or 

powder (Sigma) 
vii. Microscope slides, acid washed and coated with poly-L-lysine (Sigma) 
viii. Copling vessels (for washing slides) 
ix. Carnoy’s reagent (9:1, methanol:acetic acid). Once prepared (500 ml) it 
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can be kept for up to one month at 4°C  
x. Epifluorescence microscope equipped with (x400-600) magnification and 

either fluorescence optics for blue excitation with green and red emission 
for sequential colour capture (greyscale camera) OR blue excitation with 
wide band-pass emission filter for simultaneous capture with a colour 
camera. 

 
2. Sample Processing 

All samples arrive frozen in 250 µl aliquots. They should be stored at -80°C prior to 
processing. 

i. Rapidly thaw sample out by placing in a 37°C water bath. Mix gently and 
slowly add 500 µl of pre-warmed (to 37°C) PBS, continuing to mix gently. 
Pellet sperm by centrifugation at 500g for 10 min at room temperature and 
remove supernatant. 

ii. Using a 100 µl Gilson-type pipette, gently resuspend the pellet in 100 µl of 
PBS held at room temperature and add another 400 µl of PBS, mixing 
gently.  

iii. Centrifuge as before and resuspend pellet in 150 µl of PBS. 
iv. Refer to and follow SoP M1 to optimise sperm density.  
v. Add 10-20 µl of the suspension (15 µl if concentration is low) to either side 

of a pre-coated glass side (coated side) and spread manually using the 
pipette tip to a diameter of up to 0.5 cm. Note a cytospin can also be used.  

vi. Place slides on clean blotting paper and allow to air dry for at least 60 min.  
Slides can be stored at this point at 4°C in covered containers for later 
use. 

vii. OPTIONAL Wet slides by immersing them in water for 5 min. 
viii. Transfer slides into 0.1M HCl for 30 sec followed by 0.1M NaoH for 30 

sec. 
ix. Fix sperm by transferring slide to Carnoy’s solution for 2 hours at room 

temp. 
x. Allow to air dry for at least 60 min (on blotting paper). Slides can be stored 

at this point in covered slide containers at 4°C for later use. 
xi. If slides were stored cold, allow to warm up at room temp for 5 min.  
xii. Prepare a 12µg/ml solution of acridine orange stain by diluting 6 µl of 

commercial stock (20 mg ml) AO solution from Polysciences, inc. Cat# 
24603 to 10 ml of working solution with dd water. This should be freshly 
prepared. It does not keep well so any unused working reagent should be 
disposed. 

xiii. Under subdued lighting, flood slides with 1.0 ml AO for 5 minutes. 
xiv. Run off AO into a suitable container and place in slide rack (preferably 

glass). 
xv. Rinse slides free of AO by immersing rack in a glass staining vessel filled 

with stirring distilled water for 5 min. 
xvi. Change the water a minimum of three times (5min each); if after 3 

washes, the background is too high, when viewing under green 
fluorescence (see below), increase the number of sequential washes. 

Allow to air dry for 60 min and add a drop  of DPX mountant. Slides can be stored at this 
point in covered slide containers at 4°C for later use. Protect them from light. Note that 
alternative mountants, including those with anti-fade reagents are not recommended. 
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3. Sample Imaging and Analysis (see separate SoP for analogue and digital quantitation). 
 

4. Reference: Erenpreiss J, Bars J, Lipatnikova V, Erenpreisa J, Zalkalns J. Comparative 
study of cytochemical tests for sperm chromatin integrity. J Androl. 2001 Jan-
Feb;22(1):45-53. PubMed PMID: 11191087. The SoP is based on the TAO Method 
reported by Tejada et al. 
 
Tejada RI, Mitchell JC, Norman A, Marik JJ, Friedman S. A test for the practical 
evaluation of male fertility by acridine orange (AO) fluorescence. Fertil Steril. 1984 
Jul;42(1):87-91. PubMed PMID: 6724015. 
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Standard Operating Procedures (SOP) for: Standard Operating Procedures (SOP) for: Image 
capture and quantitation of acridine orange assay. 
 
SOP Number: 06 Version Number: 3 
Effective Date: 15-02-2016 Review Date: 15-02-2018 
 
Authors: David Miller, Alex Hargreaves 
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown - Laboratory Co-Lead 

PCTU-reviewed by 
(Name/ Position): 

 

 
Authorisation: 
Name / Position David Miller – HABSelect Chief Investigator 
Signature  

Date  
 
Purpose and Objective: 
 Purpose: To image and measure levels of sperm DNA fragmentation using Acridine Orange 
staining. 
Objective: To provide robust measures of red and green fluorescence, the ratio of which, 
indicates relative DNA fragmentation in each sperm examined. A subjective manual 
assessment will be made for audit purposes, followed by an objective automated analysis for 
high throughput. 
Scope: To provide a measure on at least 50 sperm nuclei in each sample.  
 
SOP Text 
 
Introduction to the technique:  

See SOP04 for prior sample processing and SOP05 for staining steps in the AO assay. The 
Leeds imaging platform uses a system of ‘simultaneous’ green and red imaging, recording with 
an ~450nm blue excitation filter coupled to a wide band-pass emission filter allowing 
wavelengths of 500nm and above to pass through the same excitation/emission block. Emitted 
green and red light is sequentially captured using the same in-line filters employed for visible 
light capture (see SOP M2). Alternatively, conventional epifluorescence optics for green and 
red fluorescence using independent excitation/emission blocks can be used. In either case, a 
cooled (Hamamatsu) high definition 16 bit greyscale camera is used for image capture. Leeds 
uses SmartCapture imaging software running on an Apple iMac. Images are collected from a 
Zeiss Axiomat microscope fitted with epifluorescence and bright field optics and capable of 
capturing images at x10(0), x25(0), x 40(0) and x100(0) (oil) magnification.  
 
 
Responsibility 

Suitably qualified personal in the research lab trained to perform the acridine orange assay. 
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Activity 
1. 
 Setting up for imaging 

Assay Calibration. You will already have prepared slides from a fresh sperm sample 
exposed to H2O2 (positive control) or processed without exposure (negative control). This 
is to enable you to calibrate the capture software. You will already have checked under 
the microscope that the positive control sample fluoresces dominantly in the red and the 
negative control, dominantly in the green (see SoP NN). Control slides cannot be re-used 
for this purpose and should be replaced with fresh controls if the assay needs 
recalibration. However, the settings obtained should be good for many downstream 
analyses.  

i. The UV light on the microscope should be switched on at least 20 min before use. 
Ensure all objective lenses and clean and free of residual oil beforehand by 
cleaning with 70% ethanol and allowing to air dry. 

ii. After switching on the UV light, switch on the camera and colour filter block. 
iii. Ensure the colour filter block is in place in the microscope’s C-mount. 
iv. Ensure that no light can pass through the microscope by flipping the barrier lever 

to the ‘on’ position. 
v. Launch SmartCapture and select the AO-HABSelect setting from the dialogue box 

that appears on launch. 
vi. Ensure block 2 (wide band pass emission filter) is in place in the rotating block 

holder. 
vii. Place the positive control slide on microscope stage and select x40 objective. 
viii. Flip the barrier lever to the ‘off’ position and adjust the focus so that you can see 

sperm fluorescing.  
ix. Activate SmartCapture live imaging (the > icon in the figure below). Ensure the 

image is correctly focused before continuing. Avoid exposing the sample to 
excessive UV light by flipping and keeping the barrier lever ‘on’ and only to ‘off’ 

when capturing an 
image.  

x. In the 
SmartCapture image 
capture settings 
window, set the 
exposure to 
‘automatic’ and 

ensure ‘Save 8-bit’ is 
UNCHECKED. Also 
ensure that only ‘green’ 
and ‘red’ channels are 
checked on. Blue should 
be off. 

xi. Flip barrier lever 
to ‘off’ and capture 
image (click the camera 
icon in the figure above).  
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xii. Viewing through the microscope, locate another suitable field and then refocus for 
live imaging in SmartCapture (click the > icon). Capture image using the same 
settings as before (click camera icon). Ideally, you should capture at least two 
fields.  

xiii. Take a note of the red (positive) channel exposure time (exposure boxes in figure 
above). 

xiv. Repeat steps vii – xiii with the non (H2O2) exposed (negative control) sample, again 
noting down the red and green exposure times. The red and green exposure 
times should be shortest for the positive and negative control sperm, respectively. 
The reverse will be the case for the longest exposures. If your readings accord 
with this, then the capture settings have been optimised for both channels.  

xv. It is now very important to UNCHECK automatic exposure for both red and green 
channels and type in the SHORTEST exposure times you noted down for each 
channel. SmartCapture is now calibrated for sample readings. These ‘fixed’ 
exposure settings should be good for many downstream analyses, provided that 
all sample processing steps are identical.  

If it is not possible to undertake calibration as above, samples can be imaged using the 
same settings for both channels (auto exposure must be OFF and the 8 bit capture 
unchecked). However, the optimal exposure time (not under or overexposed for each 
channel) MUST be empirically determined.  
 

2. Sample readings 
i. Place sample slides on the stage, focus and find fields you can use for image 

capture. 
ii. Ensure that automatic exposure is UNCHECKED and that you have typed in the 

shortest exposure values in the green and red channel boxes, respectively. Also 
make sure that ‘save 8 bit’ is UNCHECKED.  

iii. Capture as before, following steps in section 5.  
 

3. Image quantitation. 

There are two methods that can be used for image quantitation: subjective and objective. 
Higher magnification (x1000) may be necessary for the most accurate objective results, 
but reasonable accuracy can still be obtained for x400 – x600 if the larger number of 
imaged fields required at x1000 proves unworkable. 
 

1. A subjective analogue measure is possible, where sperm are given a score of 
+++ for all green and −−− for all red fluorescence. Anything in between (yellow) is 
designated ++− or +−− depending on whether the colour tends towards green or 
towards red. The scores should be taken on the image, NOT on the microscopic 
observation and can be done at any time after image capture. The operator 
should note the number of sperm in each of the three categories and then express 
them as a % of the total number of sperm assessed.  For semi-objective 
quantitation, two trained observers should undertake this task and their scores 
should vary by no more than 10%. In the image above, A is +++, B is ++-, C is ++-
and D is ---. If pictures are being exported for assessment on a different computer, 
ensure they are correctly marked and Export as RGB TIF files. 
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2. Image J 

 
For more objective quantitative analysis, Image J (or Fiji) is used. This software 
measures the arbitrary greyscale levels stored in the two-channel image comprising 
orange- and green- emission filtered exposures of the same field. The typical image size 
is 1300 x 1000 pixels, or at 40x magnification, a field of 250 x 200 microns. 

The first step is to use an AppleScript macro (Windows version not available) that 
converts nested folders of the SmartCapture 3 Filmstrips to two-channel TIFFs.  The 
macro also collates the exposure times for each channel to a text file: 
       SC3_AppleScript_exposures_batch_FINAL.scpt 

Running a second Applescript file afterward may help to keep conformity in the filename 
syntax: 
               AO_renamerscript.scpt 
The pipeline described below is available as an ImageJ macro file: 
               ImageJ_AO_16bit_final2.ijm 
This macro targets nested folders of SmartCapture3 TIFF as input, then for each image, 
performs preprocessing and segmentation steps. It then calculates and stores the mean 
and standard deviation of the pixel values for each sperm segment in both green and 
orange frames. 
 
i. Preprocessing: The nested folder for input images is selected with a specific syntax 
based on export of TIFFs from SmartCapture.  The background is first subtracted using 
a rolling-ball algorithm (radius 50 pixels or 8 µm) to tare the 'zero' pixel value to 
foreground contributions only.   
 
ii. Segmentation: Each individual nucleus must then be segmented so that measurements 
can be recorded by individual sperm rather than by field.  Taking a maximum-value 
projection of the image and thresholding above some constant pixel brightness 
(220/255 in 8-bit, upper 14% of range) gives a binary mask from only bright foreground 
objects, excluding fewer than 0.5% of sperm cells.  The closed islands in the mask are 
split into individual cells by watershed algorithm. To eliminate debris and cells other than 
sperm, the resulting set of objects is filtered by area (50 – 1000 sq. pixels, or 1.3 – 26 
µm2) and circularity (4π x area/perimeter2 = 0.60-0.96). 
 
iii. Uncorrected 'acquired colour ratio': The mean and standard deviation of the 
distribution of pixel values within each remaining object are calculated for orange and for 
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green frames.  The ratio of these mean pixel values then forms a green/orange 
'acquired colour ratio' for each nucleus: 
 
ACR = (mean green pixel value) 
           (mean orange pixel value) 
 
As the uncorrected ACR is confounded by varying exposure times in green and orange, it 
does not depend only on the true colour of the sperm. It is skewed by the relative 
brightness of sperm cells to other objects in the same field. 
 
Iii. Corrected 'intensity colour ratio': The true light intensity emitted from each object is 
proportional to the rate at which pixel brightness accumulates over an exposure; that is to 
say, the mean pixel value divided by the corresponding exposure time.  The ratio of 
true intensities is:  
 
ICR =  (mean green pixel value / green exposure time) 
           (mean orange pixel value / orange exposure time) 
      
 
ICR  =  ACR x (orange exposure time) 
                        (green exposure time)  
 
The exposure times are recorded automatically by SmartCapture at the point of 
acquisition.  The correction factor applies in the same way for both fixed and automatic 
exposure settings.  For less damaged (green) sperm, ICR > 1, and ICR < 1 for an orange 
sperm. 
 
For each sample, the ICR distribution over multiple sperm has a mean and standard 
deviation. These are reported as is.  However, to compare with other measures of DNA 
fragmentation the ICR must be converted to DFI: 
 
DFI  =  1 / (1 + ICR) 
 
A final metric, 'damaged % by AO', is defined as the fraction of sperm whose DFI lies 
above an empirical threshold of 0.65 as calibrated in Birmingham.  This is a binary 
categorical measure of the distribution rather than a linear average over all sperm.  The 
metrics reported are all numeric and dimensionless.   
 
For 8-bit uncorrected AO:    ACR mean, ACR standard deviation. 
For 16-bit uncorrected AO:  ACR mean, ACR standard deviation. 
For 16-bit corrected AO:  ICR mean, ICR standard deviation, number of sperm analysed, 
Damaged %. 

The following Python script: 

       AOexcelcollator_TIFFexposures.py 

collates the ImageJ results and the exposure times from the nested sample folders to a 
summary Excel spreadsheet, in which the ICR and DFI are calculated for each sperm.   
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The mean and standard deviations of these per-sperm metrics are then calculated and 
reported for each sample with sufficient sperm n > 50. 

  
 
Version Reason for Change Date Approved 
1.0 Original   
2.0 Minor optimisation and refinement  
3.0 ImageJ analysis pipelines and reported metrics 

(Alex Hargreaves) 
 

 
List of appendices 
 
Appendix Appendix name 
A  
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Standard Operating Procedures (SOP) for: HALO assay. 

 

SOP Number: 07 Version Number: 1.0 
Effective Date: 15-02-2016 Review Date: 15-02-2018 
 

Author: David Miller 
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown - Laboratory Co-Lead 

PCTU-reviewed by 
(Name/ Position): 

 

 

Authorisation: 

Name / Position David Miller – HABSelect Chief Investigator 

Signature  

Date  
 

Purpose and Objective:  
Purpose: To measure sperm DNA fragmentation. 
Objective: The assay uses a proprietary HALO assay to measure the relative intactness and 
hence quality of sperm chromatin. This is achieved by measuring the extent of halos 
surrounding sperm nuclei following their treatment with proprietary reagents supplied by the 
company (Halotech). It is based on the Sperm Chromatin Dispersion (SCD) test (Fernández 
et al, 2003). 
Scope: To allow the rapid assessment of at least 50 sperm nuclei in each sample. 
 

SOP Text 

 

 

 

Introduction to technique 

Intact unfixed spermatozoa are immersed in an inert agarose microgel on a pre-treated glass 
slide. An initial acid treatment denatures DNA in those sperm with fragmented DNA. 
Following this, the (supplied) lysing solution removes most of the nuclear proteins and in the 
absence of massive DNA breakage, produces nucleoids with large halos of spreading DNA 
loops emerging from the central core. The nucleoid from spermatozoa with fragmented DNA, 
however do not show a dispersion halo or the halo is minimal. 
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Responsibility 

Suitably qualified personal in the research lab trained to perform HALO assay. 

 

Activity 
1. Reagents and equipment required 

1. See instruction and protocol sheet supplied by the manufacturer (Appendix 1). Do 
NOT follow the general sperm preparation SoP. 

Brightfield microscope equipped with x40-60 objective. 

2. Sample Processing 

Follow instruction and protocol sheet supplied by the manufacturer. (Appendix 1). See below 
for guidance images of Wright-stained sperm processed through the supplied SCD protocol. 

3. Sample Imaging. Always refer to supplied instructions for the setting up of the Leica DM 
RBE microscope before using it. 

 
1. Place slide on microscope stage. 
2. Switch on visible light source. 
3. Using a blank slide and the x40 (or x60) objective, adjust condenser, aperture and 

field diaphragms to give optimal visibility. 
4. Place sample slide on stage and select the x10 objective initially.  
5. You will need to visualise at least 50 sperm per sample and preferably 100, so the 

number of fields required for assay imaging depends on the number of sperm visible 
in any individual field. Examples of (Wright stained) sperm halos are shown in the 
figure below. 

 

4. Recording Images and image quantitation 

There are two methods that can be used for image quantitation.  
1. A subjective, analogue measure is possible, where sperm are given a score of 

+++ for a large halo, ++- for a medium halo, +-- for a small halo and --- for no 
halo or degraded sperm. The scores should be taken on the captured image, 
NOT on the microscopic observation and can be done at any time after image 
capture. The operator should note the number of sperm in each of the four 
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categories and then express them as a % of the total number of sperm assessed.  
For semi-objective quantitation, two trained observers should undertake this task 
and their scores should vary by no more than 10%. In the image above, 1 is +++ 
(not fragmented), 2 is ++- (mildly fragmented), 3 is +-- (fragmented) and 4, 5 is --- 
(heavily fragmented). 

6. Image J 

See separate SoP05 for digital quantitation of halo dimensions using Image J. 

7. References 
1. Fernandez JL, Muriel L, Goyanes V, Segrelles E, Gosalvez J, Enciso M, et al. Simple 

determination of human sperm DNA fragmentation with an improved sperm chromatin 
dispersion test. Fertil Steril. 2005 Oct;84(4):833-42. PubMed PMID: 16213830. Epub 
2005/10/11. eng. 
 

2. Fernandez JL, Muriel L, Rivero MT, Goyanes V, Vazquez R, Alvarez JG. The sperm 
chromatin dispersion test: a simple method for the determination of sperm DNA 
fragmentation. J Androl. 2003 Jan-Feb;24(1):59-66. PubMed PMID: 12514084. Epub 
2003/01/07. eng 

 

Version Reason for Change Date Approved 

1.0  

 

 

2.0  

 

 

 

List of appendices 

 

Appendix Appendix name 

A Manufacturer’s Protocol Sheet for Halosperm® 
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Application

Instructions for use

to consult instructions of use

use by

manufacturer

health surveillance device
for in vitro diagnostics

temperature limitation

keep dry

halotech ®  ®halosperm



     

HABSelect Mechanistic SOP07_v1.0_15-02-2016 Page 5 of 5 

 

 

 



     

HABSelect Mechanistic SOP_04_v1.0_15-02-2015 Page 1 of 3 
 

08 
Standard Operating Procedures (SOP) for: Aniline blue staining of sperm 
 
08 08 Version Number: 1.0 
Effective Date: 15-02-2016 Review Date: 15-02-2018 
 
Author: David Miller 
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown - Laboratory Co-Lead 

PCTU-reviewed by 
(Name/ Position): 

 

 
Authorisation: 
Name / Position David Miller – HABSelect Chief Investigator 
Signature  

Date  
 
Purpose and Objective:  
Purpose: To stain sperm samples with Aniline Blue. 
Objective: To evaluate sperm chromatin integrity. 
Scope: Chromatin integrity assay. 
 
SOP Text 
 
 
 

Introduction to technique 
The proportion of well-condensed sperm heads (i.e. the quality of the DNA condensation within 
the sperm head) can be evaluated on smears by the percentage of heads not stained by acidic 
aniline blue staining. More precisely, Aniline blue binds lysine-rich histones in immature sperm.  
  

 
Responsibility 
Suitably qualified personal in the research lab trained to perform the Aniline Blue assay. 

 
Activity 
1.  Reagents and equipment required 

Unless otherwise stated, all working stocks and solutions MUST be made up with Analar 
grade reagents.  

i. Methanol: M/4056/17, Fisher 
ii. Acetic acid: A/0400/PB17, Fisher 
iii. PBS tablets: 18912-014, Gibco 
iv. Ready to use Aniline blue: B8563, Sigma 
v. Polysine adhesion slides: 631-1349 ThermoScietific  
vi. Distilled water 
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i. Microscope slides, acid washed and coated with poly-L-lysine, Thermo 
Scientific 2800AMNZ or VWR 631-0107. 

ii. Cover slips (22x22mm 0.13-0.17mm thick, Fisher MCS22222, SLS 1200-
03-14 or Smith Scientific NPS13/2222). 

iii. Eppendorf tube 1.5ml, Sarstedt 72.690.001. 
iv. Copling vessels (for washing slides). 
v. Fixative composed of methanol and acetic acid (3:1). 
vi. 2.5% (w/v) Aniline Blue in 2% acetic acid (freshly made). 

2. Sample Processing and staining 
All samples arrive frozen in 250 µl aliquots. They should be stored at -80°C prior to 
processing. 

i. Rapidly thaw sample out by placing in a 37°C water bath. Measure sample 
volume when transferring to Eppendorf tubes and slowly add 250 µl PBS, 
mix it gently and add make the volume up to 1.5 ml using PBS. 

ii. Centrifugation at 600g for 10 min at room temperature and remove 
supernatant and keep the pellet. 

iii. Using a 100 µl Gilson-type pipette, gently resuspend the pellet in 100 µl of 
PBS and add another 400 µl of PBS, mix it gently and make the volume up 
to 1.5 ml using PBS. 

iv. Centrifuge as before and resuspend the pellet in 100 µl of PBS. Measure 
the final volume to calculate total sperm count in the sample. 

v. Refer to and follow SoP 01 to optimise sperm density.  
vi. If the sperm concentration is low pellet sperm as before. Remove the 

supernatant, leave 10-20µl of the supernatant (PBS) to resuspend the 
pellet with. Apply 200-300 * 103 sperm onto the slide as a drop.  

vii. Place slides on a clean blotting paper and allow to air dry for at least 60 
min.  Slides can be stored at this point at 4°C in covered containers for 
later use. 

viii. Fix sperm by immersing slides in a solution of Methanol/acetic acid (3:1) 
for 60 min at room temperature. 

ix. Allow to air dry for at least 60 min.  
x. If you have a crease pen, circle the sample. Keep the fixed slides in the 

fridge if you are not staining that day. 
xi. Flood the slide with Aniline blue staining solution for 20 mins at room 

temperature.  
xii. Wash the slides by dipping in water for 3sec, gently shake or dab the 

slide. 
xiii. Repeat step xii. 
xiv. Leave to air dry for 1 hour on the bench. 
xv. Mount with DPX using cover slip, leave to set. 
xvi. Store in the fridge with silica pouches. 

  
3. Sample Imaging and Analysis (see separate SoP 10 for analogue and digital 

quantitation). 
 

4. Reference 

-Auger J, Mesbah M, Huber C, Dadoune JP. Aniline blue staining as a marker of sperm 
chromatin defects associated with different semen characteristics discriminates between 
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proven fertile and suspected infertile men. Int J Androl. 1990 Dec;13(6):452-62. 

-Sellami, A. et al. 2013. Assessment of chromatin maturity in human spermatozoa: useful 
aniline blue assay for routine diagnosis of male infertility. Adv Urol. 2013, p578631.  
Tejada RI, Mitchell JC, Norman A, Marik JJ, Friedman S. A test for the practical 
evaluation of male fertility by acridine orange (AO) fluorescence. Fertil Steril. 1984 
Jul;42(1):87-91. PubMed PMID: 6724015. 
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Standard Operating Procedures (SOP) for: Image J quantitation of captured images (Leeds 
local version) 
 
SOP Number: 09 Version Number: 1 
Effective Date: 15-02-2016 Review Date: 15-02-2018 
 
Author: David Miller 
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown - Laboratory Co-Lead 

PCTU-reviewed by 
(Name/ Position): 

 

 
Authorisation: 
Name / Position David Miller – HABSelect Chief Investigator 
Signature  

Date  
 
Purpose and Objective: 
 Purpose: To provide robust, digital measures of thresholded ‘blobs’ on captured images. 
Objective: Wholly objective imaging not subject to operator bias. 
Scope: Any downstream analysis reliant on numerical input. 
 
SOP Text 
 
Introduction to the technique:  

This procedure applies to Image J processing of digitally captured images that will normally be 
full colour or greyscale and relies on measuring pixel brightness in individual channels (red, 
green and blue). See SOPs 04 and XX for prior sample processing for AO and aniline blue 
assays, respectively. The basis of the process is the measurement of pixel ‘brightness’ in 8 bit 
or preferable 16 bit greyscale image. Colour images will normally be split into their respective 
red, green and blue channels prior to conversion of each channel to 16 bit greyscale for this 
purpose. Uncompressed TIF images are recommended so capture settings or export functions 
in other SoPs should be set for 16 bit capture (8 bit unchecked in SmartCapture) and exported 
as uncompressed TIFs. 

 
Responsibility 

Suitably qualified personal in the research lab trained to perform the acridine orange assay. 
 
 
 
 
 
 
 

Activity 
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1. 
 The open source 64 bit Image J package is needed for this procedure (check Google). 

This software runs in a Java environment, which must be installed on the computer 
workstation where the image analysis is being run. The choice of workstation platform is 
irrelevant and Windows, Mac and Linux are all supported. Any reasonably modern 
computer with at least 2Gb of RAM and a good quality colour display can be used. See 
below for general and specific examples. 

General Instructions for Image J: - 

With Image J running:- 

i. Drag and Drop the uncompressed RGB TIF or JPG of your choice on to the 
Image J toolbar or navigate to the file using the menu File → Open → Directory 
(where file resides) menu choices. 

ii. Select menu Image → Type → and set to 8 bit or 16 bit depending on whether the 
original is an 8 bit of 16 bit image. The colour image should change to greyscale. 

iii. Select menu Image → Adjust → Threshold. The Threshold dialogue box should 
open and objects in the window frame should transform from white or grey to red. 
If they are not red, ensure that the Threshold options are set to ‘Default’ and 
‘Red’. Use the upper slider to ensure as much of the object as possible is painted 
red but without overlapping another nearby object. 

iv. After clicking the ‘Apply’ button in the Threshold box, objects in the frame should 
revert to white on a black background. 

v. Select menu Process → Binary →Watershed. This should separate any 
overlapping objects.  

vi. Select menu Analyze → Analyse Particles. An analyse particles dialogue box 
should open. Ensure that the Show has ‘overlay outlines’ and ‘Add to Manager’ 
checked. When the OK button is pushed, a new ‘ROI Manager dialogue box 
should open). You can dismiss the two other boxes but keep the ROI Manager 
open. Objects in the threshold window should now be numbered. If they are not, 
uncheck and recheck the Labels option in the ROI Manager. 

vii.  Go back to threshold window and select menu Image → Overlay → Flatten. This 
ensures that the labelled objects are preserved when you save the image by 
selecting menu File → Save As → Jpeg to a destination of your choice. Name the 
file such that it can be associated with the original file image and include ‘LUT’ in 
the filename. For example, if the original file that you split into three channels is 
called ‘file_123’, name this new file, file_123_LUT. You can now dismiss all open 
windows including the image window but keep the ROI Manager open.  

viii. Reopen the original image and select menu → Color → Split Channels. The 
three colours comprising the original image will open in separate windows. 
Assuming that an RGB image was opened, the channel’s colour will be on each 
window’s title bar. 

ix. Dismiss the window(s) of any channel(s) that you are not interested in.   
x. Select one of the open ‘color’ windows by clicking on it. Go back to the ROI 

manager and ensure ‘Show all’ and ‘Labels’ are checked. The numbers should 
reappear on each object. 

xi. In menu Analyze → Set Measurements, ensure that area, integrated density and 
mean gray value are all checked.  

xii. Shift-select all objects in the ROI Manager window and press the ‘Measure’ 
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button. A new ‘Results’ window will open showing information about the 
thresholded objects in the channel window. 

xiii. Select the other ‘color’ window; there is no need to uncheck and recheck labels in 
the ROI Manager but the labels may not be visible unless you do so. 

xiv. Repeat step xii to select all objects and press ‘Measure’. The Results window will 
have all measurements for this channel placed beneath the original output. If a 
blue channel were available, the process would be repeated and the output added 
below. The number of rows in the results will therefore depend on the number (n) 
of objects (O) and the number of channels measured (C) where rows = On x Cn.  

xv. Closing the window will bring up a ‘save results’ dialogue that you should accept, 
naming the file according to the original image identifier. This is important to 
ensure that the measurements correspond to the image from which they were 
derived. We suggest that you save the original image, its LUT image and the 
Excel results in a folder names after the original image.  

 
2. Sample reading for red /  green including acridine orange and live / dead. 

Use the red and green channels. The measured outputs in the case of red-green images 
will provide green and red pixel intensity measurements that are recorded on the saved 
spreadsheets. To obtain ratios from these, use the Mean (Gray) values (IntDen or 
RawIntDen measures give similar results) and divide one by the other. In AO staining, 
dividing the green signal with its corresponding red signal will give ratios where 1.0 is 
yellow, >1.0 tends to green and <1.0 tends to red. The opposite will be the case if red is 
divided by green but the same relationship applies. 

 
Check the results against subjective scoring (+++ to – – –) on the original colour images. 

Ratios (green/red) for Acridine Orange images would be in the range 1.24-2.42 (A), 0.94-
1.28 (B), 0.85-0.94 (C) and 0.44-0.68 (D) 

3. Sample reading for aniline blue or other blue stains. To be developed 
 

 

 
 
 
Version Reason for Change Date Approved 
1.0  
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Standard Operating Procedures (SOP) for high-throughput quantitation of Aniline Blue images

SOP Number: 10 Version Number: 1
Effective Date: 15-02-2016 Review Date: 12-10-2017

Author: Alex Hargreaves
Reviewed by 
(Name/ Position):

Jackson Kirkman-Brown - Laboratory Co-Lead

PCTU-reviewed by
(Name/ Position):

Authorisation:
Name / Position David Miller – HABSelect Chief Investigator
Signature

Date

Purpose and Objective:
Purpose: To obtain frequency measures of staining classification for individual sperm in 
brightfield images of aniline blue histological slides.
Objective: To provide robust measures of aniline blue (AB) staining by imaging under 
brightfield illumination, including automated classification not subject to operator bias outside 
training sets.
Scope: To provide a measure on at least 50 sperm nuclei in each sample.  Analysis provides 
database of sperm including comprehensive image metrics and staining classification.

SOP Text

Introduction to the technique: 

Aniline blue (AB) is a histological stain whose strength indicates poor compaction of DNA in
sperm. See SOP04 for prior sample processing and SOP08 for staining. The procedure below
uses the suite of CellProfiler open source software to process and analyse digital images
obtained through colour brightfield microscopy.  The pipeline comprises five distinct parts:
cataloguing metadata, image processing, segmentation, training and classification. Processing
involves homogenisation of each unmixed image from the catalogued set in turn - presenting a
well-defined, uniform input for calculation of a vast number of image brightness and shape
characteristics. The segmentation of brightfield images into constituent sperm necessarily
depends on object shape as well as intensity information. For a ‘training set’ of images, these
sperm segments are classified according to a moderated manual scoring.  This primes an
artificial intelligence algorithm to then classify all sperm segments automatically.

Responsibility

Suitably qualified personnel with proficiency in manual aniline blue scoring and CellProfiler and
CellProfiler Analyst software.
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3 Automatic image quantification

Our motivations for developing automated analysis are the following: improved speed, 
low maintenance, inherent objectivity, reproducibility, and production of records at every 
step.  However, automated approaches often struggle to determine which (of the myriad 
possible) parameters are important for classification, even in cases where the 
classification is obvious to the eye. Offsets are to be expected in accuracy and ease of 
use compared to the manual analysis.

Machine learning offers a general approach to image classification starting from a 
preclassified subset. It solves the problem above, in that it does not require the range of 
characteristics of each category to be defined explicitly in advance, but defined during 
training. Once trained, automated classifiers based on machine learning become highly 
specialised.  As such, the classifier will be more accurate if variants are dedicated to 
each acquisition route (viz. Birmingham and Leeds).

i. Software Installation

The open source 64 bit CellProfiler and CellProfiler Analyst packages are needed for this 
procedure. This software runs in a hybrid Java / Python environment, prerequisites of 
which must be installed on the computer workstation where the image analysis is being 
run.  Windows XP+ is preferred for compatibility (Bootcamp is supported for Mac). As this
procedure is very computationally intensive, RAM of at least 4x the size of each image 
batch should be used to avoid memory saturation errors (e.g. >16 GB of RAM for 2000 
images each of 2 MB). For speed, images should be stored local to the machine, such as
on an external hard drive. A typical pipeline takes a few minutes per image / no. cores.

ii. Cataloguing and image I/O

CellProfiler requires a metadata file – a spreadsheet of comma-separated values 
containing a full list of image filenames, dimensions etc. from which it can derive correct 
import settings.  
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An example which generates *.csv files is given in: 
384_wellplate_metadata_csv_generator_final.xls

In Windows a list of filenames within the current folder and its subfolders can be 
extracted to file using the command prompt as follows:   
          > dir –s –b > filelist.txt
This can be used to build the metadata file.  Including Plate and Well fields in the 
metadata for each image allows later use of the Plate Viewer feature in CellProfiler 
Analyst (see iv. Training).  This provides an interactive graphical overview of the results, 
which can be helpful in identifying subsets in the images, or patterns of poor 
segmentation.

iii Processing and segmentation
The CellProfiler interface includes a preamble for Metadata (see above) and Image 
import (drag and drop image files from Windows Explorer e.g. *.png, *.tif).
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Finally image processing modules are listed in a custom sequence known as a pipeline.  
Each module represents a processing step such as resizing, splitting colour channels or 
creating masks or objects.  It may include options such as a choice of algorithms and 
heuristic parameters that need to be specified for the particular use. These settings are 
saved as pipeline project files (*.proj), e.g:
            SpermHeadandImagePreprocess_UK_LDS_4_314_83_314_263.proj

The Aniline Blue pipeline is as follows: 
1. UnmixColors – transforms the raw RGB colour image to a greyscale ‘unmixed’ 

image using a known colour map for the stain.
2. ColorToGray –  splits the RGB channels for later visualisation
3. MeasureImageQuality / IdentifyPrimaryObjects / 

MeasureObjectIntensity / MeasureObjectIntensityDistribution 
– quantify whole-image characteristics such as focal quality, background flatness 
and whether it contains large clumped areas of sperm.

4. EnhanceOrSuppressFeatures / PerObjectEllipseFit / 
IdentifyPrimaryObjects / MeasureObjectIntensity / 
MeasureObjectIntensityDistribution – the first is a processing step 
which reduces the contrast in thin features only.  This suppresses the appearance
of the sperm tails. The second function is a bespoke algorithm (Petter Ranefall, 
Uppsala University) which segments non-overlapping elliptical objects of the 
expected size for sperm heads. The remainder act to measure a large number of 
arbitrary shape and intensity characteristics of the segments. During training, the 
classifier will sift through this data to identify significant mathematical differences 
between categories.

5. ClearMemory – erases some intermediate image types from memory to free up 
space for the heavy calculations on segments. 

6. SaveImages – saves images and segmented outlines for visualisation
7. ExportToDatabase – saves calculated metrics for each segment in each image
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to a database.

The segmentation looks similar to this example (thin green lines denote segments). The 
false positives must be screened out at the classification stage (debris, bottom left 
patches):

The project file contains the heuristic settings for each of these modules. Alongside the 
saved images, the completed calculation generates a *.properties file (for 
CellProfilerAnalyst) and an associated SQL *.db database, e.g. the attached:
             spermpreprocessLDS_314_83_314_263.properties
      spermpreprocessLDS_314_83_314_263.db            

iv Training

A training set of a recommended 5-10% of the total images are processed and 
segmented first. It is crucial that these represent the diversity of the full set, so it is best 
to select most of them randomly plus a few outlier cases by inspection.  At least 25% of 
the training set images must have already been scored manually (see ii. Manual Scoring)
by at least three authors and standardised according to a number of classifications 
compatible with the desired model. The manual scoring for sperm under aniline blue 
stain is typically tertiary: ‘++’, ‘+-‘, ‘--‘, as described in Section 2.  The automated scoring 
will reflect this.

With the SplitChannel/ColorToGray and SaveImage modules activated in the pipeline, 
the human-readable image content (colour image with segmentation outlines) can be 
interrogated in CellProfiler Analyst via the properties file.  The Classifier tool allows 
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categories to be built, corresponding to different degrees of staining, in our case of four 
classes: ’Weak’=’--‘, ‘Medium’=’+-‘, ‘Strong’=’++’, as well as ‘Debris/Error’= false positives
in segmentation. Debris typically comprises stained immune cells, glass particles, stray 
fibres and dark patches of background. This classifier model and training set can be 
stored in *.model files and *.csv spreadsheets respectively.

Segments are gathered (with the ‘Fetch’ button) and assigned (manual drag and drop) to 
populate the model categories.  Only those segments with a clear phenotype are 
retained. The classifier algorithm is FastGentleBoosting with <15 max rules.  These rules 
are iteratively trained (‘Train’) to maximise the diagonal elements of the confusion matrix 
(via ‘Evaluate’).  Training is very fast, taking just a few seconds but needs refinement 
iteration by iteration. If the phenotypes are underspecified or too few rules are used, the 
classifications will appear random unless particular to the cases selected.  If they are 
overspecified, some categories will overlap and the classifier will confuse them.   
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v Classification

In CellProfiler, a separate copy of the processing and segmentation pipeline is set up for 
fast processing, with SplitChannel and SaveImage modules disabled (greyed out) to 
save memory. Run the truncated analysis pipeline batchwise on the remaining images.

In CellProfiler Analyst, open each properties file in the Classifier and load the classifier 
model so that the categories appear in the same order.  Copy the rules from the text file 
into the ‘Edit Rules’ field.  Use ‘Score All’ and export each ‘Hit Table’ to a spreadsheet. 
Collate the spreadsheets using Excel or similar.  The AB stain is reported here as the 
percentage of sperm (in strong, medium and weak categories) which fall into the strong 
and medium categories combined for samples with >50 sperm only:

% (++ & +-)  =   100 x (n  Strong + n  Medium)       {for (nStrong + nMedium+ nWeak) > 50}
                        nStrong + nMedium+ nWeak

The distributed results for each metric can be interrogated using the Plate Viewer, where 
each row of spot rep resents a sample, each spot represents a segment or an image, 
and its colour the value of that metric. It also allows inspection of the raw and segmented
images, as well as plotting the multivariate distributions of the selected metrics. This is 
very useful for auditing the data.
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Standard Operating Procedures (SOP) for: HALOSperm Assay with Giemsa staining 
 
SOP Number: XX Version Number: 1.0 
Effective Date: 15-02-2016 Review Date: 15-02-2018 
 
Author: David Miller 
Reviewed by  
(Name/ Position): 

Jackson Kirkman-Brown - Laboratory Co-Lead 

PCTU-reviewed by 
(Name/ Position): 

 

 
Authorisation: 
Name / Position David Miller – HABSelect Chief Investigator 
Signature  

Date  
 
Purpose and Objective:  
Purpose: 
Objective: 
Scope: DNA fragmentation assay. 
 
SOP Text 
 
 
 
Introduction to technique 

Intact unfixed spermatozoa are mixed in an inert agarose micro gel on a pre-treated 

slide. An initial acid treatment denatures the DNA in the cells with fragmented DNA. 

Following the denaturation step, the lysis solution removes most of the nuclear 

proteins. Absence of massive DNA breakage produces nucleoids with large halos of 

spreading DNA loops, emerging from central core. In contrast, the nucleoids from 

spermatozoa with fragmented DNA either do not show a dispersion halo or the halo 

is minimal. 
  
Responsibility 
Suitably qualified personal in the research lab trained to perform the HALOSperm 
assay. 
All human samples should be treated as potentially hazardous and Personal Protective 

Equipment (lab coat and gloves) must be worn at all times. 

 
 
Activity 
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1.  Reagents and equipment required 
Unless otherwise stated, all working stocks and solutions MUST be made up 

with Analar grade reagents.  

The kit (HT-HS10) contains materials for 10 tests: 

SCS (Super coated slides), 10 slides with two sample areas 

ACS (Agarose Cell support) 10 Eppendorf tubes with agarose 

DA (Denaturing agent) 1ml 

LS (Lysis Solution) 100ml 

Specific materials and equipment required but not provided with the kit: 

Specimen: 

The semen sample can be fresh or cryo preserved. If frozen, the sample should 

be fully thawed, brought to room temperature and processed immediately. 

Other: 

Distilled water 

Ethanol 

Incubator for 90-100°C and 37ºC (heat block) 

4°C refrigerator 

Glass slide covers (22x22mm or 18x18mm) 

Portable cold surface (ice pack or pre-cooled metal tray) 

Giemsa stain, modified (GS500, Sigma Aldrich) 
 

2. Sample Processing 
All samples arrive frozen in 250 µl aliquots. They should be stored at -80°C prior 

to processing. Wash each sample twice with a volume up to 1.5ml of PBS. 

Centrifugation at 600x g for 10min. Re-suspend the sperm pellet ideally to a 

concentration of 5-10 x 106 sperms per ml. If the sperm count is lower, the 

volume is kept as small as possible to use the whole sample and the ratio 

between sperm and agarose be kept 1:4. 
HALOSperm Assay 

i. Keep the slides horizontally at any time. 
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ii. Set the Lysis solution (LS) at room temperature. 

iii. Place the agarose tubes in the heat block at 90-100°C for 5min 

until the agarose dissolves.  

iv. Transfer the agarose tubes to the 37°C heat block and leave for 

5min. 

v. From now on, work a sample at the time to avoid solidification of 

agarose and uneven distribution of sperms on the slide. 

vi. Add 25µl or smaller volume of the semen sample to an agarose 

tube with appropriate volume and mix well by pipetting gently up 

and down several times without creating bubbles. Return the tube 

to 37°C.  

vii. Add 15µl of the sperm-agarose mix onto the pre-treated side of the 

SCS slide and cover with a cover slip. 

viii. Place the slides on a cold surface and incubate at 4°C for 5min. 

Note that the incubation time will be longer for the first samples as 

it is for the last. 

ix. Prepare the denaturing solution by adding 80µl of the kit’s DA 

solution into 10ml of distilled water. 

x. Remove the cover slip by sliding it gently off to the side. 

xi. Immediately, flood the slides with the diluted denaturing solution 

and incubate at room temperature for 7min. No wash between 

denaturing and lysis. 

xii. Lyse the slides by immersing the slides in 10ml undiluted lysis 

solution for 25min. 

xiii. Wash by submerging the slides in distilled water for 5 min. 

xiv. Dehydrate the slides through 70%, 90% and 100% Ethanol, 2min 

each 

xv. Leave to air dry at room temperature 

xvi. Continue to Giemsa staining 

Giemsa staining 
xvii. Make a 1:10 dilution of Giemsa stain in distilled water. Incubate the 

slides with Giemsa stain for 60min at room temperature. 

xviii. Wash the slides gently by dipping in distilled water. Leave to dry at 
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room temperature.   

xix. No cover slips are needed. 
 

3. Sample Imaging and Analysis (see separate SoP for analogue and digital 
quantitation). 

 
4.  
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